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01 INSTALLATION AND PREPARATIONS 

What is LectureMAKER? 
LectureMAKER is a multimedia authoring tool based on the full-fledged concept of user-created contents 
(UCC) with which you can author e-learning contents in various forms.  
LectureMAKER lets you easily create vividly realistic video lectures using the sound recording, video 
recording, and electronic board functions as well as utilizing the existing data such as from PowerPoint slides, 
PDF documents, video files, sound files, etc.  
 

p Product Composition 
n Authoring tool 

LectureMAKER generally means an authoring tool. It is used to create and edit lecture content.  

n Viewer 
This is used to read the content created through the authoring tool. It is an indefinitely freeware 
program.  

p Main Functions 
n Function of setting up a slide master 

You can use the slide master to apply the author’s signatures, navigation buttons, designs, font 
types and sizes, etc., used together on several slides to every slide altogether in the same way.  
This shortens the user’s authoring time and reduces the size of lecture files.  

n Function of inserting various multimedia 
You can optimize and insert various multimedia objects without using any extra application. You can 
insert or create image, video, and sound files. In the case of a large-capacity video object, you can 
minimize its capacity through a link instead of inserting it directly.  

n Function of controlling videos 
Inserting a bookmark in a video will let you quickly move to the portion you want to view and learn 
through section repetition the next time you play it.  
Moreover, you can synchronize videos with slides; thus maximizing the effectiveness of teaching 
and learning.  

n Providing various layouts, designs, and templates 
Various forms of content layouts and designs are provided so that you can compose various types 
of content by simply combining them.  
Moreover, by utilizing templates, you can easily create e-learning content combining video and text, 
voice and text, etc.  

n Function of convenient interactions 
Various learning support functions such as the menu button for learning overview, Navigation button 
for the learning progress, Click button for learning interactions, etc., are easily implemented.  

n Function of authoring content through the utilization of multimedia 
You can create effective lectures through voice recording, video recording, and electronic writing by 
using the webcam, microphone, and electronic board functions.  
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Installation Environment and System Requirements 
 

p Hardware 
n CPU: Pentium IV 2.x GHz or higher 
n RAM: 2GB (4GB or more recommended) 
n HDD: Minimum of 300MB or more free hard disk space 
n Display: Minimum resolution of 1024 x 768 

 

p Software 
n Platforms 

OS: Windows XP or higher (Windows 7 recommended) 
JavaScript: Internet Explorer 9 or higher (Chrome recommended) 

n Programs that need to be installed 
Windows Media Player 9: This program is used for playing multimedia files.  
Windows Media Encoder 9: This program is used for recording and/or converting multimedia audio 
and video. (A machine running a 64-bit operating system requires the installation of the 32-bit 
English version.)  

n Related program download sources 
Windows Media Player: http://www.microsoft.com/windows/windowsmedia 
Windows Media Encoder: http://www.microsoft.com/windows/windowsmedia/forpros/encoder/default.mspx 
Windows Internet Explorer: http://www.microsoft.com/windows/Internet-explorer 
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Online and Offline Authentication 
p Online Authentication 

If  you have purchased a l icense for the product, you can use it after completing 
authentication by entering the product serial number f irst, clicking the Online 
Authentication Request button, and then following the corresponding instructions.  
 

p Offline Authentication 
If  online authentication is impossible because your computer is not connected to the 
Internet, please notify us of your product key and your personal code by email or phone, 
and then complete authentication after receiving an authentication code from us.  

  
 

PLEASE NOTE: 
If you have not purchased a copy of LectureMAKER, you can experience it for 30 days by clicking “Use as a Trial 
Version.”  

 

Online Update 
You can check for updates of LectureMAKER regularly. If your computer is connected to the Internet, 
LectureMAKER will automatically check for updates every time you run the program. If an update is available, 
it will let you know it by means of a popup window. In this case, proceed with the update by following the 
instructions.  
 
 
 

Online Questions and Customer Support 
p Online Questions 

n Support services website for the product group: http://www.lecturemaker.co.kr/en 
n View installation: http://viewer.lecturemaker.co.kr 
n Samples: http://sample.lecturemaker.co.kr 
n Textbook: http://textbook.lecturemaker.co.kr 

 

p Customer Support 
n Questions about purchase/price/cooperation: biz@daulsoft.com  
n Questions about technical support/how to use: csc@daulsoft.com  
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02 GETTING STARTED 

Screen Configuration 

 
A. Quick Launch toolbar: You can use tools on the Quick Launch toolbar to work quickly. Add 

frequently used tools to the toolbar.  
B. Title bar: This displays the name of the file you are currently working on.  
C. Screen Adjustment button: This minimizes, maximizes, or closes LectureMAKER windows.  
D. Ribbon menus: These are a collection of menus. All menus except the file menu are ribbon-style 

ones organized in the stages of [Menus – Groups – Commands]. The file menu is a dropdown-style 
one.  

E. Slide List window: Provides a thumbnail preview of slides  
F. View buttons: These are a collection of tools for a set of commands for viewing, running, adding, 

and deleting slides.  
G. Slide window: This is the actual work area for a slide.  
H. Object List window: This is a list of objects inserted on a slide window.  
I. Slide Status bar: This displays the location of the slide you are currently working on, total number of 

slides, and size of the screen.  
J. Zoom tool: This lets you optionally enlarge or reduce the edit area of a slide.  
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LectureMAKER Menu Configuration 
The menu bar in LectureMAKER consists of the following menus: File, Home, Insertion, Design, View, and 
Format; all the menus except the File menu are ribbon-style unfolding menus.  
 
File This is a collection of commands for managing files.  

 
 
Home This is a collection of basic commands for editing documents.  

 
 
Insert This is a collection of commands for inserting or generating objects into slides.  

 
 
Control  This is a collection of commands for controlling inserted objects.  

 
 
Design This is a collection of commands for applying the backgrounds, layouts, and templates of design 
slides.  

 
 
View This is a collection of options, executions, etc., for viewing slides as well as the slide master.  

 
 
Format This is a collection of commands for changing the properties of selected objects.  
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Using the Clipboard 
Use the commands in the [Home-Clipboard] group to copy/cut and paste or duplicate objects or object 
properties.  

 
 

p Copy 
You can copy/cut and paste objects.  
1. Use the [Home-Clipboard-Copy (Ctrl+C) or Cut (Ctrl+X)] command to copy or cut the selected object.  
2. Use the [Home-Clipboard-Paste (Ctrl+V)] command to paste the copied or cut object.  

 

p Duplicate 
You can duplicate the selected object(s). Duplicate objects as many as the number of 
times the Duplicate command is executed are generated.  
1. Select an object you want to duplicate, and then click the [Home-Clipboard-Duplicate (Ctrl+D)] 

command.  

 
 

p Copy Attribute 
You can copy the attr ibute of a shape and paste them to the attribute of another.  
1. Select the object(s) whose attribute you want to copy, and then click the [Home-Clipboard-Attribute-

Copy Attribute (Ctrl+Shift+C)] command.  

 
2. Select the object(s) to which you want to apply the copied attribute, and then click the [Home-

Clipboard-Attribute-Paste Attribute (Ctrl+Shift+V)] command.  
 

PLEASE NOTE: 
Use the [Set as Default Attribute] command when you want to set a selected object attribute as a default value for a 
new shape. For example, if you set a red-edged rectangle as a default attribute, all the shapes to be created after 
that will be drawn as red-edged ones.  



 

 
13 

Slide View 
p Viewing Several Slides on One Screen 

You can switch to View Multi Slide mode to view multiple slides in the f ile you are working 
on.  
1. Clicking the [View-View Slide-View Multi Slide] command displays multiple slides on one screen.  

  
2. You can switch back to View Default Slide mode by clicking the [View-View Slide-View Default Slide] 

command.  

PLEASE NOTE:  

You can switch between View modes by clicking the View Default Slide icon  or the View Multi Slide icon  in 
the View buttons at the bottom of the [Slide List window].  

 
 

p Enlarging/Reducing Slides 
You can enlarge or reduce the Edit Slide window.  
1. Click the [View-View Slide-Zoom] command.  

 
2. When the [Zoom] dialog box appears, adjust the zoom percentage to the desired level.  

 

PLEASE NOTE: 
Adjust the zoom percentage to the desired level by clicking the Zoom Out /Zoom In  icon on the Zoom toolbar at 
the bottom of the program or by moving the zoom slider .  
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Object List Window 
The Object List window displays a list of objects inserted in the slide.  
It also serves as a window showing the run sequence because the objects appear sequentially, starting with 
the object located at the top of the Object List window when the slide is run.  

 
 

p Icons on the Object List Window 
The icons for each object on the Object List window respectively hide or lock their 
corresponding object and make their object invisible when run.  
The function of each icon is as follows:  

n The Eye icon  indicates that its corresponding object is visible on the slide window. Clicking the 
Eye icon to change into the Closed Eye icon  will make its corresponding object invisible.  

n Clicking the Key icon  to change into the Locked Key icon  will lock editing for its 
corresponding object.  

n The Run icon  indicates that its corresponding object starts to run when a slide is run. If it is 
changed into an unchecked icon , its corresponding object will not start to run when a slide is run.  

 

p Types of Objects 
n General objects: general text boxes, pictures, shapes, etc.  

n Window objects: These include buttons, videos, electronic boards, Web pages, edit mode text boxes, 
etc. Window objects are always displayed above the other types of objects regardless of object 
arrangement. For example, if pictures have been arranged above videos, the videos are hidden by 
the pictures on the edit screen but displayed above the pictures on the run screen.  

n Control objects: inserted commands in the [Control-Object Control] group displayed in blue color on 
the Object List window  

PLEASE NOTE:  
To show or hide the Object List window, click the [Object List Window] command under [Home-Edit-Select] or 
uncheck the [Format-Order-Object List Window] command.  

   
To select all objects on the Object List window, click the [Select All (Ctrl+A)] command under [Home-Edit-Select].  
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Object Property Window 
Used for setting object properties, this window consists of [Objects], [Color and Line], and [Location and Size.  

1. Double-click an object on the [Object List window].  
2. Change the object properties on the [Object Property window], and then click [OK].  

 
n Objects: You can set the properties of the selected object. (The reference images are the property of the 

[Image] object.)  
n Color and Line: You can set the fill and/or borders of an object.  
n Location and Size: You can set the position and/or size of an object.  
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Order, Align, Group, Undo Edit, and Redo Edit 
p Changing the Order of Objects 

You can change the order of objects by sending them to the front, forward, back, and 
backward.  
1. Select the objects whose order you want to change, and then click the [Home-Edit-Order] command.  

 
2. Click the desired order in the [Order] command under [Order].  

 

PLEASE NOTE:  
Double-clicking the objects whose order you want to change activates the [Format] menu. Change the order at 
[Format-Order] group. 

 

PLEASE BE CAREFUL:  
Order does not apply to window objects such as video, Web pages, buttons, lecture recordings, etc. They are 
arranged such that they precede other types of objects.  
Window objects, however, are arranged in the order of Video, Web pages > menu buttons > buttons > lecture 
recordings. 
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p Aligning Objects by Line, Interval, and Size 
You can align objects by regular lines and intervals and equalize their sizes.  
1. Select two or more objects, and then click the [Home-Edit-Order] command.  
2. Click the command you want to apply in the [Align] command under [Order].  

 

PLEASE NOTE: 
Double-click the objects to go to the [Format] menu, and then change their order in [Align] under the [Order] group.  

 
 

p Group and Ungroup 
You can put the selected objects together into a group and ungroup them.  
1. Select objects, and then click the [Home-Edit-Order] command.  
2. Click [Group] in the [Group] sub-command under [Order].  

 
3. To ungroup the specified objects in a group, click [Ungroup].  
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p Saving as Group Template 
You can save the selected group as a template. You can use the saved template in the 
[Design tab-Template] group.  
1. Select [Group] objects and click the [Home-Edit-Order] command.  
2. Click [Save as Group Template] in the [Group] sub-command under [Order].  

 
3. In the [Save Template] dialog box, enter the [Name], and then click [Save].  

 
4. To call up a group, select the group you want to call up in the [Design-Template] group; the group will 

then be inserted into your slide window.  
 

p Undo Edit and Redo Edit 
You can cancel the command you have just executed and recover the canceled command 
as well. 
1. Click [Home-Edit-Undo Edit (Ctrl+Z)] to cancel the command execution.  

 
2. To restore the canceled command, click [Home-Edit-Redo Edit (Ctrl+Y)].  
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Grids and Rulers 

 
 

p Grid 
You can edit your document more precisely when moving objects by means of the dots 
that appear at regular horizontal/vertical intervals on a slide window.  
1. Click the [View-Show/Hide-Ruler and Grid] command.  

 
2.  Adjust the grid intervals in the Grid and Guideline dialog box. (Default value: 8 pixels)  

 
 

p Ruler 
The rulers indicate the width and height of a document. You can show or hide them on 
your edit screen.  
1. Clicking the [View-Show/Hide-Ruler and Grid] command hides the rulers.  

 
2. Clicking the command again shows the rulers.  

 
 



 

 
20 

Viewing Multiple Windows 
The number of document windows you are allowed to open at the same time is limited to 9. Moreover, 
opening and using multiple documents may be confusing. In this case, according to the number of document 
windows, you can arrange them properly for the full screen.  
 

p Cascade View 
Click the [View-Window-Cascade] command. 

  
 

p Tile View 
Click the [View-Window-Tile] command.  

  
 

PLEASE NOTE: 
When there are several open files, but one file has been maximized, thereby making it difficult for you to switch over 
to another file, press the (Ctrl+Tab) key to switch over to it.  
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Shortcut Keys 
 

Working with Files New file Ctrl+N 
Open a file Ctrl+O 
Save the file Ctrl+S 
Save as Web page Ctrl+Alt+S 
Print Ctrl+P 
Exit the program Alt+F4 
Help F1 

 
Running Slides Run slide F5 

Run current slide Shift+F5 
Run a slide in full screen mode Ctrl+F5 
Run by Web browser Alt+F5 

 
Moving to Another 
Slide 

First slide Home 
Last slide End 
Next slide PgUp 
Previous slide PgDn 

 
Editing 
Objects/Slides 

Copy Ctrl+C 
Cut Ctrl+X 
Paste Ctrl+V 
Duplicate Ctrl+D, Ctrl+Drag 
Copy formatting Shift+Ctrl+C 
Paste formatting Shift+Ctrl+V 
New slide Enter, Ctrl+M 

 
Selecting Objects Select/Deselect Ctrl+Click 

Select all Ctrl+A 
Select next object Tab 
Select a scope Shift+Click 
Select a previous object Shift+Tab 
Select multiple objects Shift+Click, Ctrl+Click 
Select a scope on the Object List 
window 

Shift+Click 

Select multiple objects on the 
Object List window 

Ctrl+Click 

 

Changing the 
Object 
Size/Moving 
Object 

Preserve the aspect ratio Shift+Control Point 
Change the main criterion Ctrl+Control Point 
Change the object size minutely Alt+Control Point 
Adjust straight lines at 15-degree 
intervals 

Shift+Drag 

Adjust and move minutely Alt+Drag 
Change the object size in grid 
units 

Shift+Arrow Key 

Change the object size minutely Shift+Ctrl+Arrow Key 
 

Others Object Property window Alt+Enter 
Record a lecture Ctrl+E 
Undo Ctrl+Z 
Redo Ctrl+Y 
Zoom in/out a slide window Ctrl+Mouse Wheel 
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03 ATTEMPTING CREATION 

Importing a File 
1. Click the [File-Open] command.  

 
 

2. In the [Open] dialog box, select a “……/Lets ABC_sample” file, and then click [OK] to import it.  
(Sample File Folder : [File-View Sample-Open the data folder]) 

 
 

3. An example file is opened as shown below.  
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Completing a Title Slide 
1. Inserting Background Music in the Title Slide(Data Folder : [File-View Sample-Open the data folder]) 

Click the [Insert-Object-Sound] command, select the “intro” file, and then click [Open] in the [Open] 
dialog box.  

 
2. Inserting Title Pictures 

Click the [Insert-Object-Image] command, select the “funfun” file in the[Open] dialog box, and then 
click [Open] to insert a title picture. After selecting the picture, drag it to adjust its position.  

 
 

 
3. Creating a Button for Moving to the Main Slide 

Click the [General Button] command under [Insert-Object-Buttons], and then draw a button by 
dragging it on the slide window.  
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4. Changing the Button Properties 
After choosing a button on the slide window, select [Object Property] after right-clicking to open the 
Object Property window.  

    
 
① Delete the word “Button” from the [Button Name] item.  

 
② Change [Button Shape] to [Image Button].  
③ Click the Open icon  of the [When Mouse is Not over the Button] item, select the “go” file, 

and then click [Open].  
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④ Select [Move to Next Slide] by clicking the dropdown menu of the [When Mouse is Clicked] item, 
and then click [OK] on the [Object Property window] to close it.  

 
5. The title slide is completed as shown below.  

 
 

Running the Title Slide 
1. Running the Slide 

Press [F5] on the keyboard to run the slide.  
2. Confirming the run window 

Confirm the run window. Background music runs; clicking the “Go button” shows the next slide.  
3. Closing the run window 

Click the [Close] icon to close the run window.  
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Completing an Alphabet A Slide 
1. Moving to No. 2 Slide 

Click No. 2 slide on the [Slide List window] on the left side.  

 
2. Applying Animation to Pictures 

① Double-click the “capital A” image to go to the [Format] menu. Apply the [Stripes] command in 
the [Animation] group.  

 
② Select the “lowercase a” image, and then apply the [Stripes] animation command in the 

[Format] menu.  
③ Select the “apple” image, and then apply the [Stripes] animation command in the [Format] menu.  

3. Confirming the Animations on the Current Slide 
Run the slide by pressing the [Shift+F5] key and confirm the animations applied to the pictures.  

4. Creating a Sound Button for “A” 
Create a button for hearing the pronunciation of the “A” button.  
Click the [General Button] command under [Insert-Object-Button], and then draw a button by 
dragging it on the slide window.  

   
5. Changing the Button Properties 

After choosing a button on the slide window, select [Object Property] after right-clicking to open the 
Object Property window.  
① Delete the word “Button” from the [Button Name] item.  

 
② After changing [Button Shape] to [Image Button], click the Open icon  of the [When Mouse 

is Not over the Button] item, select the “headset” file, and then click [Open].  
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③ Select the “A.wav file” by clicking the Open [Sound File] icon  of the [On Mouse Click] item, 

and then click [Open].  

 
④ Click [OK] on the [Object Property window] to close it.  

6. Confirming the Animations on the Current Slide 
Run the slide by pressing the [Shift+F5] key and confirm the animations applied to the pictures.  

 
 

Saving 
1. Save your work by clicking the [File-Save] command.  
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04 CREATING A SLIDE 

New Slide and Copy/Delete Slide 
p Creating a New Slide 

You can create a next slide by clicking the [Home-Slide-New Slide (Ctrl+M)] command.  

 

PLEASE NOTE: 
When you select a slide on the [Slide List window], and then press [Enter], a new slide will be added behind the 
selected one.  

 
 

p Copying/Deleting a Slide 
You can copy or delete the selected slide by means of the [Duplicate/Delete Slide] 
command in the [Home-Slide] group.  

 

PLEASE NOTE: 
You can use the Edit Slide command by right-clicking a slide on the [Slide List window].  
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Setting the Slide Size 
You can set the slide size by taking into account the execution environment for the content.  

1. Click the [Design- Slide Setup-Slide Size] command.  

 
2. Select the desired size in the [Slide Size] dialog box, and then click [OK].  

 
n Slide Size: Please change the size of a slide to the aspect ratio of 3:2 or 4:3 or such that it fits the mobile 

environment.  
n Preserve Aspect Ratio: When you change the size of a slide to the desired size, the slide size is adjusted 

to the aspect ratio.  
n Object Location and Size: When changing the size of the slide you are working on, select the scope of 

applying such change.  
n Set as Default: Items selected for the size properties of the current slide are applied to a newly created file 

as default values.  
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Setting the Slide Properties 
You can set the properties such as slide name, slide background, moving to another slide, etc.  

1. Click the [Design-Slide Setup-Slide Property] command.  

 
2. Change the properties in the [Slide Property] dialog box, and then click [OK].  

 
n Slide Name: You can change the name of the slide.  
n When Starting a Slide: You can apply the background color or background image of the slide.  
n Apply to all slides: This applies the set background color or the background image to all slides.  
n Move to the Next Slide: Press the mouse button or the key to go to the next slide; you will also be directed 

automatically to the next slide after a certain amount of time.  
n Use mouse right popup menu: When running the slide, decide whether to use the mouse right popup 

menu or not.  
n Do not apply Slide Master to this slide: If you click this, no content in the slide master will apply to the slide.  

PLEASE NOTE: 
You can open the [Slide Property] dialog box on the empty area of the slide by selecting [Slide Property] after right-
clicking.  
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Slide Control 
p Moving to Another Slide 

You can move to another slide at the desired t ime and in the desired manner by inserting 
the [Goto Slide] command of the [Control] menu.  
1. Click the [Control-Slide Control-Goto Slide] command.  

 
2. If you click [OK] after selecting a slide you want to move to in the [Move] item of the [Object Property 

window], the [Goto Slide] control object is inserted into the [Object List window].  
The control command object is displayed in blue color on the [Object List window].  

   
3. You can change the time to move to another slide by moving the order of the [Goto Slide] control 

command on the [Object List window].  
 

p Transition to This Slide 
Switching between screens gives the effect of slides appearing.  
1. Select the desired effect in the [Control-Transition to This Slide] group to apply the slide transition 

effect.  

 
2. Create various effects by setting the [Direction], [Speed], and [Gap] of the applied slide transition 

effect.  
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Running a Slide 
To get a preview of the content you have worked on, select the method for running a slide in the [View-Run 
Slide] group.  

 
n Run All Slide (F5) 

Displays a preview of all the slides starting with the first slide  

n Run Current Slide (Shift+F5) 
Displays a preview of slides starting with the currently edited slide 

n Run Full Screen (Ctrl+F5) 
Displays a preview of the full screen of your computer monitor starting with the first slide  

n Run Web (Alt+F5) 
Displays a preview of the content on a browser  

PLEASE NOTE: 

When running the current slide, you can run slides by clicking the Run from current slide icon  in the View Slide 
tool at the bottom of the [Slide List window] by means of the command you frequently use during work.  
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05 SLIDE DESIGN 

Slide Master 
p What is the Slide Master? 

The slide master is the top slide for saving the design and layout information for the 
content including backgrounds, colors, fonts, effects and object frame sizes and positions. 
Using the slide master saves t ime because you need not enter the same information in 
different slides.  
The slide master consists of the title master and the body master. The tit le master applies 
to the No. 1 slide. The body master applies to all other slides being generated start ing 
with the No. 2 slide.  

 
 

p Editing the Slide Master 
1. Click the [View-Slide Master-View Slide Master] command to switch to Edit Slide Master mode.  

 
2. Click the [Close Slide Master] command to return to Slide mode.  

PLEASE NOTE: 

Click  of the [Slide List window] to shift to Slide Master mode; click  to return 
to Slide mode.  
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Design 
You can easily change the slide background using the provided designs. The selected designs are applied to 
the background of the slide master. Besides the default design, you can also add a design.  

1. Click the [Design] menu.  

 
2. If you select the desired [Design] by clicking the Arrow icon or the Unfold icon in the [Design] group, 

your selection is applied. The selected design is applied to both the title master and the body master.  

   
3. In addition, selecting [Apply to Selected Slides] after right-clicking the [Design] group applies the 

selected design to the new masters starting with the current slide.  

 

PLEASE NOTE: 
Design files are managed using the mouse right-click popup menu in the [Design] group.  
- Export Design File 
- Import Design File 
- Delete Design File 
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Layout 
Layout contains the fonts, positions, and object frames of the contents displayed on the slide. You can insert 
text boxes, pictures, videos, video recordings, PowerPoint files, PDF files, and/or Web browsers into an 
object frame.  
When you apply layouts to a slide, the cover layout  is applied together with the contents of the title 
master and the other layouts together with the contents of the body master.  

1. Clicking a layout in the [Design-Layout] group applies it to the selected slide.  

 
2. In addition, you can apply layouts using the mouse right-click popup menu of [Layout].  

 
3. Select an object frame and enter contents.  

 

PLEASE NOTE: 
The following objects may be inserted into the object frame of the body text:  

 text box,  picture,  video,  video recording,  PowerPoint,  PDF,  Web page 
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Template 
Templates are forms designed by combining background images and layouts. You can author content easily 
if you embellish your screen and insert objects using the provided templates. Besides the provided templates, 
you can create a template file and add it to the template list.  

1. Click the [Design] menu.  

 
2. Select the desired [Template] by clicking the Arrow icon or the Unfold icon in the [Template] group to 

apply it to the slide.  

   
 

PLEASE NOTE:  
Template files are managed using the mouse right-click popup menu in the [Template] group.  
- Export Template 
- Import Template 
- Delete Template 
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06 FILE MANAGEMENT 

What are the Types of LectureMAKER Files? 
n LME: You can edit them in Authoring Tools.  
n LMD: You can only view files of this type in Viewer.  
n LMM: Files of this type are design files.  
n LMT: Files of this type are template files.  

 
In the [File] menu, you can check and confirm some information concerning the task, printing, and program 
related to the file.  

 
 

Creating a New File 
Clicking [New(Ctrl+N)] in the [File] menu opens a new file.  
 

Open 
p Importing an existing file 

1. Click the [File-Open(Ctrl+O)] command.  
2. In the [Open] dialog box, select a file, and then click [Open].  

 

p Importing a recent document 
[File-Recent Documents] is a list of recently opened or saved documents. Using this 
menu, you can easily call up frequently used documents.  

 

p Importing a design format file 
1. Click the [File-Open] command.  
2. In the [File Format] menu at the bottom of the [Open] dialog box, change the file format to the 

[Design Format Files (*.lmm)], and then select a file and click [Open].  
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Close 
p Closing a file 

Click the [File-Close] command to close the current document.  
 

p Closing all files 
Click the [File-Close-Close All] command to close not only the currently active document 
but also all the open documents.  

 

Save 
p Saving a file (Ctrl+S) 

Click the [File-Save] command to save the current document.  
 

p Saving all files 
Click the [File-Save-Save All] command to save not only the currently active document 
but also all the open documents.  

 

Save As... 
Click the [File-Save As] command to save the current document in a different name.  
 

Print 
n Click the [File-Print (Ctrl+P)] command to print the current document.  
n Click the [File-Print-Print Preview] command for a preview of the current document before printing it.  
n Click the [File-Print-Print Setup] command to set the printer, paper orientation, etc.  



 

 
39 

Information 

 
n Copyright 

Copyright Information: Set the company and author information for the document.  
Copyright Reserve: Set the content such that it may be run only on specific domains.  

n Help (F1) 
Click this to run the Help command.  

n Visit Website 
Click this to go to the LectureMAKER website.  

n View Update 
Click this to confirm the updated contents.  

n License 
This menu appears when you use the trial version of LectureMAKER. You can confirm the period of 
using the trial version. If you have the product serial number, you can activate LectureMAKER 
immediately.  

n About LectureMAKER 
Click this to confirm the program version information of LectureMAKER.  

 
 
 



 

 
40 

 

07 DOCUMENT INSERTION 
You can insert PowerPoint, PDF, and/or Web page documents into your document using the [Insert-Object-
Document] command.  

 
 

Inserting a PowerPoint 
You can import a PowerPoint document and reuse it as a learning resource.  

1. Click the [Insert-Object-Document] command, and then select [PowerPoint] under [Document].  

 
2. When the mouse pointer changes to a cross (+), drag to the desired size.  
3. In the [Open] dialog box, select a PowerPoint file, and then click [Open].  
4. Select an insertion type in the [Import PowerPoint File] dialog box.  

 
5. Select an image format in the [Image Format] dialog box.  

 
6. Set [Size].  

 
7. Select the slide to insert, and then click [Import Selected Slides].  
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Alternatively, to insert all the slides, click [Import All Slides].  

8. As many slides as you have selected are added into your document.  
 
 

Inserting a PDF 
You can import a PDF document and reuse it as a learning resource.  

1. Click the [Insert-Object-Document] command, and then select [PDF] under [Document].  

 
2. When the mouse pointer changes to a cross (+), drag to the desired size.  
3. In the [Open] dialog box, select a PDF file, and then click [Open].  
4. Select an insertion type in the [Import PDF File] dialog box.  
5. Select an image format in the [Image Format] dialog box.  
6. Set [Size].  
7. Select the slide to insert, and then click [Import Selected Slides].  

Alternatively, to insert all slides, click [Import All Slides].  
8. As many slides as you have selected are added into your document.  
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Inserting a Web Page 
You can insert HTML documents. You can also use such online URL as http://.  

1. Click the [Insert-Object-Document] command, and then select [Web Page] under [Document].  

 
2. When the mouse pointer changes to a cross (+), drag to the desired size; the Object Property 

window will then open.  

 
3. Select HTM or HTML file by clicking the Open icon  for the [File Name (URL)], and then click 

[Open].  

 
Alternatively, to insert a Web page via its URL, enter the URL in the [File Name (URL)] item.  

4. Set the [Scroll Bar] item and the [Border] item, and then click [OK] (optional). 
5. Run the current slide by clicking [Shift+F5] to confirm the inserted document.  

PLEASE BE CAREFUL:  
When entering an online URL, you must type its path correctly including its protocol.  
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08 WORKING WITH IMAGES 

Inserting Images 
You can insert an image file. Supported image formats include BMP, JPG, GIF, PNG, WMF, EMF.  

1. Click the [Insert-Object-Image] command.  

 
2. In the [Open] dialog box, select a file, and then click [Open].  
3. Double-click Picture on the slide window, and then change the properties in the [Image] group of the 

[Format] menu.  

 
 

Changing the Image Properties 
You can change the properties of the inserted image.  

1. Double-click the inserted picture on the [Object List window] to open the Object Property window. 
Alternatively, select [Object Property] after right-clicking the image object on the slide window.  

2. Change the properties on the [Object Property window], and then click [OK].  

 
n Image ID: This ID is used to control images.  
n File Name: This is a path to the inserted image.  
n Change Size: This lets you change the size of an image.  
n Cropping: This allows you to cut out part of an image.  
n Cancel Crop: This allows you to cancel the Crop command.  
n Transparent Color: This lets you change the set color to make it transparent.  
n Animation: This lets you apply animation effects to an image.  
n Transform Effect: This lets you provide filtering, color, and/or transformation effects to an image.  
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Animation Effects 
1. Double-click an image on the slide window, and then select Animation in the [Format-Animation] 

group.  

 
2. Adjust the [Direction], [Speed], and [Gap] of animation.  
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Saving/Restoring a Screen 
The [Save Screen] command saves the screen of the area specified; you can make the saved screen appear 
again using the [Restore Screen] command.  
 

p Saving a Screen 
1. Click the [Control-Object Control-Screen] command, and then select [Save Screen] under [Screen].  

 
2. When the mouse pointer has changed to a cross (+), drag it to set the desired area.  
3. When the Object Property window appears, confirm [Screen ID], and then click [OK].  

 
 

p Restoring a Screen 
1. Click the [Control-Object Control-Screen] command, and then select [Restore Screen] under [Screen].  
2. When the Object Property window appears, choose the [Screen ID] you want to restore, the restore 

location, etc., and then click [OK].  

 
 

PLEASE REMEMBER: 
The screen area for screen saving is selected by dragging the mouse; the screen is saved at the point of time the 
[Save Screen] object is located on the [Object List window]. In other words, even if there are many objects, screen 
saving applies only to the objects located in the screen saving area among all the objects that began to be located 
earlier than the [Save Screen] object. The objects that began to be located later than the [Save Screen] object do not 
affect screen saving even if they are currently in the screen saving area.  
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PLEASE NOTE: 
The following is an example of utilizing Save Screen.  
If you insert several pictures and apply animation to them, they appear; thus accumulating one after another. To 
remove the existing pictures and show new ones on the background, use the [Save/Restore Screen] command.  
 
1. Insert three pictures into the slide window, and then apply [Animation] to each image.  

 
2. When you run the slide by pressing [F5], the pictures that appeared previously do not disappear but appear 

again; thus accumulating one after another.  

    
3. Insert the [Save Screen] command.  
4. The [Save Screen] command is located at the top of the [Object List window], which is prior to the appearance of 

the images.  

 
5. Insert the [Restore Screen] command.  
6. The [Restore Screen] command is located between Image (1) and Image (2) at the point of time the first picture 

should appear, and then disappear.  
If you apply [Animation] when restoring the screen, you can generate the animation effect of the first picture that 
appears and subsequently disappears.  
Set [Restore Screen] as well between Image (2) and Image (3).  

 
7. When you run the slide by pressing [F5], each image appears one after another, and then disappears.  
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09 WORKING WITH VIDEOS 

Inserting a Video 
You can complete dynamic content by inserting a video into your slide. Supported video file formats include 
AVI, WMV, ASF, MPG, MP4, and FLV.  

1. Click the [Insert-Object-Video] command.  

 
2. Click [Open] after selecting a video file in the [Open] dialog box.  
3. To confirm the inserted video, press the [Shift+F5] key to run the current slide.  
4. Double-click the video inserted into the slide window, and then change the properties in the [Video 

Option] group of the [Format] menu.  

 

PLEASE BE CAREFUL: 
In case some video files are not supported, check whether they are played in Windows Media Player. We 
recommend the use of WMV files in order for the video to be played smoothly.  

PLEASE NOTE: 
You can use video link to minimize the file size of documents.  
Enter the path in the [URL] item, and then click [Open URL].  
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Video Recording 
Mount and connect video recording equipment (camcorder, webcam, etc.) to your computer and record WMV 
format videos.  

1. Click the [Insert-Recording-Record Video] command.  

 
2. Select [Video] and [Audio] devices in the [Record Video] dialog box, and then set [Video Size] and 

[Video Bitrate] and click [Apply].  
Video bitrate means the number of bits transmitted per second. The lower the number is, the better 
the compression rate, but the quality of the video is also lower.  

 
3.  When you click [Start Recording], video recording starts. Click [Stop] to finish video recording, and 

then insert the video into your slide by clicking [Exit after Insert as object].  

 
4. To confirm the recorded video, click the [Shift+F5] key to run the current slide.  

PLEASE BE CAREFUL: 
Video recording requires prior installation of Windows Media Encoder. Unless it has already been installed on your 
computer, a popup window will ask you the Windows Media Encoder download. If download and installation on your 
computer are successful, then the video recording window will run normally.  
 
If there is any other video recording program running at the same time, LectureMAKER may be shut down as a result 
of conflict between the two programs. Take care not to let any other video recording program start running.  
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Changing the Video Properties 
You can change the properties of an inserted video.  

1. Double-click a video on the [Object List window] to open the Object Property window. Alternatively, 
choose a video object on the slide window, and then select [Object Property] by right-clicking.  

2. On the [Object Property window], change the properties of the video, and then click [OK].  

 
n Video ID: This is used for video control.  
n File Name: This is a path to the inserted video.  
n Play: This sets the play of the video.  

 
n Show Control Panel: The LectureMAKER Control Panel is used.  
n Show Windows Media Player Control Panel: The Windows Media Player Control Panel is used.  
n Keep Video until the Next Slide: This keeps the video until the selected slide.  
n Sync with Slide: This synchronizes the video with slides.  
n Sync with Object: This synchronizes the video with objects.  
n Disable Jump to the Location Which Has Not Been Played: This makes it impossible for the video to be 

played after jumping to the section that has not been played.  
n Keep Aspect Ratio: This keeps the aspect ratio of the video.  
n Convert: You can convert the video into WMV format.  
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Synchronization with Slide 
Slide synchronization matches the progressing time of the video with the time of moving from one slide to 
another for multiple slides based on the video.  

1. Double-click a video on the slide window to go to the [Format] menu.  
2. Click the [Format-Video Option-Synchronize] command.  

 
3. After selecting slides in the [Synchronize] dialog box, press the [F2] key, and then enter the [Sync 

Time] to move to each relevant slide sequentially.  

 
Alternatively, if you click [Synchronize] while playing the video, the playing time of the video at the 
time point of clicking Synchronize for the selected slide is entered as the sync time.  

 
4. Set the [Sync Type], and then click [OK].  

  
5. The sync time is displayed on the [Slide List window].  
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PLEASE NOTE: 
The following are the properties of the [Synchronize] dialog box.  
 

 
 
A. This provides a preview of the video.  
B. This provides a preview of the slides. You can use the [Back] icon and the [Next] icon to move between slides.  
C. Synchronize: This matches the time point of playing the video with the time point of moving to another slide. You 

can set the slide switching time by clicking Synchronize while playing the video.  
D. Remove Sync: This removes all the sync times.  
E. Preview: This provides a preview of the set synchronization.  
F. Sync Time: Enter the time of moving to the relevant slide after pressing [F2].  
G. Sync Type: Set the playing time of the video in case of playing slides or the synchronization criteria when 

moving to the previous or next slide.  
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Object Synchronization 
Object synchronization matches the progressing time of the video with the time of objects appearing. 
Although functionally separated from slide synchronization, object synchronization includes slide 
synchronization. When object synchronization is applied, its blue clock icon  is displayed on the Slide List 
window.  

1. Double-click a video on the slide window to go to the [Format] menu.  
2. Click the [Format-Video Option-Object Sync] command.  

 
3. [In the [Object Sync] dialog box, select the objects you want to synchronize with the video; after 

entering [Sync Time], click [OK].  

 
4. To apply synchronize to the objects of the next slide, move to the slide by clicking [Next] in Slide 

Preview, and then enter [Sync Time].  

 
5. In the case of the slide to which object synchronization has been applied, the sync time and its blue 

clock icon are displayed on the [Slide List window].  

. 
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Video Control 
You can control the properties (play, disable jump, double speed, full screen, volume, etc.) of a video. Use 
the Video Control command to adjust the video play time or make the Video Control command operate by 
means of objects such as button, etc.  

1. Clicking the [Control-Object Control-Video Control] command opens the Object Property window.  

 
2. Select the [Video ID] of the video you want to control.  
3. Set the properties, and then click [OK].  

 
4. Insert the [Video Control] command into the [Object List window].  
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Video and Audio Conversion 
You can convert and compress video and audio files to WMV or WMA format. Once they have been 
converted to WMV or WMA format, both streaming and progressive download are possible. Streaming lets 
you play a video without downloading it. Progressive download means playing a video while downloading it.  

1. Click the [Control-Change Format-Convert Video/Audio] command.  

 
2. Open the source file you want to convert by clicking the Open icon  and selecting it.  

 
3. The file name and save location of the [Output] are basically the file name and location of the 

[Source]. To change the file name and the save location, click the Save icon .  
4. Change the video or audio properties as follows:  

 
n Screen Captured Video: In the case of a video file containing captured screens, convert it at the optimized 

quality level.  
n Voice Audio: In the case of an audio file containing recorded voices, it is converted at a better quality level.  
n Video Bitrate: You can set the bitrate of the video. Video bitrate means the number of bits transmitted per 

second. The lower the number is, the better the compression rate, but the quality of the video is also lower.  
n Audio Format: You can select an audio format.  

5. Click [Start, and then click [Exit].  
To insert the converted file into a slide, click [Insert converted file as object].  
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10 WORKING WITH SOUND 

Inserting Sound 
You can insert sound into a slide. Supported sound formats include WAV, WMA, and MP3.  

1. Click the [Insert-Object-Sound] command.  

 
2. In the [Open] dialog box, select a sound file, and then click [Open].  
3. To confirm the inserted sound, run the current slide by clicking [Shift+F5]. By default, a sound object 

is not seen on the screen when it is run.  
4. Double-click the Sound icon inserted into the slide window, and then change the properties of the 

sound object in the [Sound Option] group.  

 

PLEASE NOTE: 
If two or more sounds have been inserted into a slide, only the last inserted sound is played. To play two or more 
sounds at the same time, insert them by clicking the [Insert-Object-Video] command.  
When the [Open] dialog box appears as a result of clicking the [Video] command, change the [File Format] into a 
sound file, and then select and insert the sound you want to insert into the slide.  
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Sound Recording 
You can mount a microphone on your computer and record, play, and edit sound in WAV or WMA format.  

1. Click the [Insert-Recording-Record Sound] command.  

 
2. Enter the [File Name] in the [Record Sound] dialog box.  

 
3. Set the [Channel], [BPS], and [Frequency].  

 
4. Start recording by clicking the Record icon  and stop recording by clicking the Stop icon . 

Listen to the recorded contents in advance by clicking the Play icon , and then edit the sound 
using the [Delete Head] button and the [Delete Tail] button.  

 
5. Insert the sound in the slide by clicking [Insert as sound object]. To uncheck [Insert as Object after 

Converting to .wma], the sound file will be inserted as a WAV file.  

 
6. To confirm the inserted sound, run the current slide by clicking [Shift+F5].  
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Changing the Sound Properties 
You can change the properties of the inserted sound.  

1. Double-click a sound on the [Object List window] to open the Object Property window. Alternatively, 
choose a sound object on the slide window, and then select [Object Property] by right-clicking.  

2. Change the properties on the [Object Property window], and then click [OK].  

 
n File Name: This is a path to the inserted sound.  
n Play: This sets the playing of the sound.  

 
n Show Control Panel: This displays the LectureMAKER Control Panel.  
n Show Windows Media Player Control Panel: Displays the Windows Media Player Control Panel  
n Show Icon: This displays the icon.  

n Icon Functions:  
n Auto Play: The sound is played when the slide is run.  
n Play/Pause Icon: This changes the icon shape.  
n Convert: This converts the file into WMA format.  
n Sync Setup: This synchronizes the sound and the slide.  
n Object Sync Setup: This synchronizes the sound and the objects.  
n Play: This lets you listen to the sound in advance.  
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Synchronization with Slide 
Slide synchronization matches the progressing time of the sound with the time of moving from one slide to 
another for multiple slides based on the sound.  

1. Double-click a sound object on the [Object List window] to open the Object Property window, and 
then click [Sync Setup].  

2. After selecting slides in the [Synchronize Slide] dialog box, press the [F2] key, and then enter the 
[Sync Time] to move to each relevant slide sequentially.  
Alternatively, if you click [Synchronize] while playing the audio, the playing time of the sound at the 
time point of clicking Synchronize for the selected slide is entered as the sync time.  

3. The sync time is displayed on the [Slide List window].  
For details, please refer to Synchronization with Slide under Working with Videos on page 51.  
 
 

Object Synchronization 
Object synchronization matches the progressing time of the sound with the time of objects appearing. 
Although functionally separated from slide synchronization, object synchronization includes slide 
synchronization. When object synchronization is applied, its blue clock icon  is displayed on the Slide List 
window.  

1. Double-click a sound on the [Object List window] to open the Object Property window, and then click 
[Object Sync Setup].  

2. In the [Object Sync] dialog box, select the objects you want to synchronize, and then, after entering 
the [Sync Time], click [OK].  

3. To apply Synchronize to the objects of the next slide, go to the slide by clicking [Next] in Slide 
Preview, and then enter [Sync Time].  

4. In case of the slide to which Object Sync has been applied, the sync time and its blue clock icon are 
displayed on the [Slide List window].  

For details, please refer to Object Synchronization under Working with Videos on page 53.  
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11 LECTURE RECORDING 

Lecture Recording 
You can write on the electronic board on your slide screen together with voice or video recording.  

1. Click the [Insert-Recording-Record Lecture (Ctrl+E)] command.  

 
2. Select [Record Sound]+[Record Electronic Board], [Record Video]+[Record Electronic Board] or 

[Record Electronic Board] in the [Record Lecture] dialog box.  

 
3. Set the color, line thickness, etc., of the ball point pen or the highlight pen.  

 
4. Clicking the Record icon  starts lecture recording; clicking the Stop icon  stops lecture 

recording.  

 
To move to another slide during lecture recording, click Previous Slide /Next Slide .  

 
5. When lecture recording has been completed, click the Save icon  to insert the recorded object 

into the slide.  

 
 

 
6. To confirm the inserted electronic board, press the [Shift+F5] key to run the current slide.  

PLEASE BE CAREFUL: 
If you cannot see a preview screen of video recording during lecture recording, please set up the device you are 
using by means of the [Insert-Recording-Record Video] command. The video recording function of lecture recording 
is linked to the Video Recording command in the Insert menu.  
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Changing the Electronic Board Properties 
You can change the properties of the inserted electronic board.  

1. Double-click the electronic board on the [Object List window] to open its Object Property window. 
Alternatively, choose the electronic board object on the slide window, and then select [Object 
Property] by right-clicking.  

2. On the [Object Property window], change the properties, and then click [OK].  

 
n Electronic Board ID: This is used for electronic board control.  
n Electronic Board File Name: This is a path to the electronic board.  
n Show Electronic Board Control Panel: This displays the Control Panel at the lower left of the slide.  
n Sync File Name: This is a file path for the video or sound worked on simultaneously together with the 

electronic board.  
n Show Electronic Board Control Panel: This displays the LectureMAKER Control Panel.  
n Show Windows Media Player Control Panel: This displays the Windows Media Player Control Panel.  
n Convert: Converts the [Sync File] into WMV or WMA format  
n Go to the Next Slide When Play is Over: Goes to the next slide when play is over  
n Adjust Synchronized Time: This compensates the time synchronized with the [Sync File] by adjusting the 

time of the [Electronic Board File].  
 

Electronic Board Control 
You can control the play of the electronic board.  

1. Click the [Control-Object Control-Electronic Board Control] command.  

 
2. Select the [Electronic Board ID] you want to control.  

 
3. Choose [Play, Pause, Stop, or Close], and then click [OK].  
4. The [Electronic Board Control] command is inserted into the [Object List window].  
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12 WORKING WITH BUTTONS 

What is a button? 
A button is a function assigned a task to do when the mouse is clicked, when the mouse pointer is placed 
over the button, or when the mouse pointer exits the button so that the learner can induce interaction with it. 
Using object and control in combination of a button lets you embody a variety of interactions.  

n General Button: This is a default button. It is used to embody a variety of interactions.  
n Menu Button: This button provides the function of serving as menu for the authored content.  
n Navigation button: This button provides the function of serving as navigation for the authored content.  

 
Creating a General Button 

1. Execute the [Insert-Object-Button] command followed by the [General Button] command under 
[Buttons].  

 
2. When the mouse pointer changes to a cross (+), draw a button by dragging it on the slide window.  
3. Double-click the button on the slide window, and then change its properties in the [Button Option] 

group in the [Format] menu.  

 
4. To give animation effect to the button, apply Animation Effect in the [Format-Animation] group.  
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Changing the General Button Properties 
You can change the properties of the general button. Set the button name, button type, button actions 
following mouse events, etc.  

1. Double-click the button on the [Object List window] to open the Object Property window. Alternatively, 
select the general button object on the slide window, and then choose [Object Property] by right-
clicking.  

2. Change the properties on the [Object Property window], and then click [OK].  

 
n Button ID: This is a button ID for controlling the button.  
n Button Name: This lets you enter the text characters displayed on the button.  
n Button Shape: This lets you choose from among [Default Button, Color Button, Region Button, Image 

Button, and Text Button].  
n On Mouse Click: This lets you set an action to be performed when the mouse pointer is placed over the 

button and the mouse is clicked.  
n On Mouse Over: This lets you set an action to be performed when your mouse comes into the button.  
n On Mouse Out: This lets you set an action to be performed when your mouse goes out of the button after 

coming into the button.  
n Tooltip: When you place your mouse pointer over the button, the Tooltip is displayed.  
n One Time Button: The button is used only once.  
n Maintenance Button: The button is maintained continuously starting with the current slide.  
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p Button Shape 
Default Button, Color Button, Region Button, Image Button, and Text Button are available.  
In the case of [Color Button], [Image Button], and [Text Button], you can specify different 
button colors or images according to mouse events.  
[Region buttons] are transparent buttons that exist only in the button regions. They 
function l ike hot spots.  

DEFAULT 
BUTTOM 

COLOR 
BUTTON 

REGION 
BUTTON IMAGE BUTTON TEXT BUTTON 

     

     
 

p Button Action 
The types of actions performed according to mouse events are as follows:  

n Show Hidden Object: This shows an object on which [Hide Object] has been set.  
n Close Object: This makes an object disappear.  
n Hide/Show Object (Toggle): This lets you embody the condition of hiding and showing an object with a 

button.  
n Call Group: This shows the specified group.  
n Go to the Previous Slide: This lets you go to the previous slide.  
n Go to the Next Slide: This lets you go to the next slide.  
n Go to the First Slide: This lets you go to the first slide.  
n Go to the Last Slide: This lets you go to the last slide.  
n Go to the Specific Slide: This lets you go to the specified slide.  
n Go to the Current Slide (Repeat): This runs the current slide again.  
n Go to the Last Viewed Slide: This lets you go to the slide you viewed immediately prior to the one you are 

currently viewing.  
n URL Link (_new): This opens a Web page on a new browser window.  
n URL Link (_self): This opens a Web page on the current browser window.  
n Download File in Web Browser: This lets you download a file by specifying a file download path.  
n Download File Directly: This lets you download a file by attaching it to a LectureMAKER file.  
n Close (Exit) Web Browser Window: This closes the Web browser.  
n Exit the Program: This exits the program.  
n Pause the Program: This stops the program temporarily.  
n Play the Program: This plays the program.  
n No Action: There is no specified action.  
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p Hiding Objects and Showing Hidden Objects 
You can embody interactions through the [Hide Object] command and the [Show Hidden 
Object] action of a button.  
1. Insert objects (picture, text box, etc.) into the slide window.  
2. Select the inserted object, and then execute the [Hide Object] command by right-clicking.  

 
3. Enter [Hide Name] in the [Hide Object] dialog box, and then click [OK].  

 
4. Insert the general button into the slide window.  
5. Select [Show Hidden Object] for the [On Mouse Click] action on the [Object Property window] of the 

button.  

 
6. Select the hidden object in the [Show Object] dialog box, and then click [OK].  

 
7. Click [OK] on the [Object Property window] to close the Object Property window.  
8. Click the button after clicking the [Shift+F5] key to confirm the action of the hidden object (picture, 

text box, etc.) appearing.  
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Creating a Menu Button 
1. Click the [Insert-Object-Button] followed by the [Menu Button] under [Button].  

 
2. When the mouse pointer changes to a cross (+), draw a button by dragging it on the slide window. All 

the slides in the menu button appear while being arranged in a menu.  

 
3. Double-clicking the menu button inserted into the slide window opens the [Menu Button] dialog box.  
4. Select a [Menu Type], change the [Menu Name], and then click [OK].  

 
To display a lower-level menu, click [Indent] to show the menu structure.  

   
5. To change the font of the menu button, go to the [Home-Font] group.  
6. To adjust the size of the menu button, select the menu button, and then drag Control Point  to 

adjust it.  

 
7. Click the [Shift+F5] key to run the current slide, and then confirm the size of the menu button and its 

actions.  

PLEASE NOTE: 
To insert a Menu button into all slides, create a Menu button in the slide master.  
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Changing the Menu Button Properties 
Double-click the menu button on the slide window, and then change its properties in the [Menu Button] dialog 
box.  

 
n Menu Button ID: This is a button ID for controlling the menu button.  
n Menu Type: This lets you choose from among List Box, Combo Box, and Button.  
n Indent/Unindent: This lets you set/cancel Indent for the Menu Name.  
n Select/Cancel All Items: This lets you choose/cancel all the menu items.  
n Menu Name: This lets you edit the menu name by pressing [F2].  

 
The types of menu buttons include list boxes, combo boxes, and buttons.  

n List Box: Shows the items through a button in the form of a list. 

 
n Combo Box: Shows only the selected items in a list through a button. Clicking the arrow shape will 

display a list from which you can select one item.  

  
n Button: Converts all the menus or the selected menus to general buttons  
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Creating a Navigation Button 
1. Execute the [Insert-Object-Button] command, and then click the [Navigation Button] under [Button].  

 
2. In the [Navigation Button] dialog box, select the button you want to show.  

 
3. Select a button shape.  

 
4. To apply this to all slides, select [Apply to All Slides], and then click [OK].  
5. A navigation button is created at the lower right of the slide.  

 
6. To confirm the actions of the navigation button, run the slide by clicking the [Shift+F5] key.  

PLEASE NOTE: 
To change the location of the navigation button, drag it. To apply the navigation button whose location has been 
changed to all slides, double-click the navigation button, and then click [Apply to All Slides] at the bottom of the 
[Navigation Button] dialog box. Finally, click [OK].  
Alternatively, you can easily apply the navigation button to all slides as well by inserting it into the slide master.  
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Changing the Navigation Button Properties 
Double-click the navigation button on the slide window, and then change its properties in the [Navigation 
Button] dialog box.  

 
n Navigation Button: You can select from among Home, Previous, Repeat, End, Next, Exit, and Slide 

Number.  
n Select All: This selects all the navigation buttons.  
n Cancel All: This cancels all the selected navigation buttons.  
n Show Right to Left: This shows the order of navigation buttons from right to left. The default value is Show 

Left to Right.  
n Button Shape: You can select a button shape.  
n Import Navigation Buttons: Besides the button shapes provided as default, you can also import the user’s 

button shapes and add them to the [Button Shape] list.  
n Apply to All Slides: This causes the navigation button to be applied to all the slides which you are working 

on.  
n Apply to New Slide: This causes the navigation button to be applied automatically to a new slide to be 

added.  

PLEASE BE CAREFUL: 
The inserted navigation button is provided as an image, so changing its size is not recommended.  
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Button Control 
You can disable, enable, or delete a button.  

1. Execute the [Control-Object Control-Button Control] command.  

 
2. Select [Target Button] on the [Object Property Window].  

 
n Button ID: This is selected as button ID for general buttons.  
n All Buttons: This controls the general buttons, navigation buttons, and maintenance buttons except the 

menu boxes.  
n General Buttons: This controls the general buttons.  
n Navigation Buttons: This controls the navigation buttons.  
n Maintenance Buttons: This controls the button set to be maintained.  
n Menu Box: This controls the menu boxes.  

3. Select [Button Control], and then click [OK].  

 
n Enable: The button becomes active, so you can press it.  
n Disable: The button becomes inactive, so you cannot press it.  
n Delete: The button is deleted, so you cannot use it.  

4. The [Button Control] command is inserted into the [Object List Window].  
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13 OTHER OBJECT 

Message Box 
You can create a dialog box for providing information or warning to learners by inserting a message box.  

1. Click [Insert-Object-Other Object], and then select the [Message Box] command under [Other Object].  

 
2. Enter a title and a message on the [Object Property window], select an icon, and then click [OK].  

 
3. To confirm the message box, run the current slide by clicking the [Shift+F5] key.  
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Calling JavaScript 
The Call JavaScript object lets you call JavaScript from HTML in LectureMAKER. To call JavaScript, insert 
the relevant JavaScript into HTML first.  

1. Execute the [Insert-Object-Other Object] command followed by the [Call JavaScript] command under 
[Other Object].  

 
Calling JavaScript from HTML involves using events. The event function is OnEvent, and the 
arguments to be delivered is variable.  

2. On the [Object Property window], list the values to be delivered to the arguments for calling 
JavaScript by separating them by commas.  
In the case of strings, bind each string using double quotation marks (").  
To call different JavaScript functions, specify the first argument value as the function separator and 
deliver it. Afterward, you can separate the value in JavaScript and call the other JavaScript function.  

 
3. Execute the [File-Export] command, and then save your document as an HTML file by saving it as a 

[Web page].  
4. Change and save the script of the HTML file, and then confirm it in a Web browser.  

 
Example) In case you have specified an argument value for a JavaScript calling object:  
"test1", 2007, 3.14, "string" 
"test1" is used as function separator with 2007 as an integer, 3.14 as a real, and a string called a 
“string” delivered.  
 
If this object is run, <script language="JavaScript" for=" LectureMaker " 
event="OnEvent(arg1,arg2,arg3,arg4,arg5)"> in an .html file will also be run. In this case, "test1" as 
the first delivered argument value will be delivered to arg1, 2007 to arg2, 3.14 to arg3, and “string” 
to arg4.  
 
The following JavaScript source shows how to call different JavaScript functions based on the first 
delivered value.  
<script language="JavaScript" for=" LectureMaker " event="OnEvent(arg1,arg2,arg3,arg4,arg5)"> 
    switch(arg1) 
    { 
      case "test1": 
        test1(arg2,arg3,arg4); 
        break; 
      case "test2": 
        test2(arg2); 
        break; 
    } 
 
 </script>  
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 <script language=javascript> 
    function test1(arg1, arg2, arg3) 
    { 
      alert(arg1 + "\n" + arg2 + "\n" + arg3); 
    } 
    function test2(arg1) 
    { 
      alert(arg1); 
    } 
  </script> 

 

PLEASE NOTE: 
In case of a file you have exported as HTML5, specify a script as an argument for calling JavaScript functions in the 
userconfig.js file in [filename.files] folder.  
For example, if you export it under the file name of abc, an [abc.files] folder will be created. Afterward, specify an 
argument for calling JavaScript functions as array in EventFire in the html5lecture.html file in the folder.  
 
_EventFire_ = function (arg) { 
   // Add event code here 
  } 
 
<Example> 
switch(arg[0]) { 
 case “test1”: 
  test1(arg[1], arg[2], arg[3]); 
  break; 
 case “test2”: 
  test2(arg[3]); 
  break; 
}
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14 TIMER CONTROL 

Time Synchronization 
Time synchronization matches the slide time with the time of objects appearing starting with the point in time 
when the slide has been run. If you apply time synchronization, an orange clock icon  will be displayed 
on the Slide List window.  

1. Execute the [Control-Object Control-Time Sync] command.  

 
2. After selecting an object in the [Time Sync] dialog box, press [F2], and then enter the [Sync Time] for 

running the object.  

 
Alternatively, if you set the [Slide Duration Time], press the Play button, and then click [Sync] the 
time of playing the slide at the point in time when you have clicked Synchronize on the selected 
object will be entered as the [Sync Time].  

 
3. If you apply time synchronization by clicking [OK], an orange clock icon will be displayed on the 

[Slide List window].  
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Pause 
Pause stops the objects in the slide temporarily. For example, if you insert the [Proceed after the seconds 2] 
command, the next object will be run two seconds later.  

1. Execute the [Control-Object Control-Pause] command.  

 
2. Select the Pause action on the [Object Property window], and then click [OK].  

 
3. Drag the [Pause] command inserted into the [Object List window] to place it over the object you want 

to stop temporarily.  
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Timer Control 
You can have a specified action repeated at regular time intervals. This function lets you embody a timer.  

p Starting the Timer 
1. Click [Control-Object Control-Timer Control], and then select the [Start Timer] command under [Timer 

Control].  

 
2. Set the [Elapsed Time] interval on the [Object Property window], select an [Action] to run, and click 

[OK].  

 
3. To use the action only once without running it repeatedly, check [Auto Off (Only Once)].  

 

p Stopping the Timer 
1. Execute the [Control-Object Control-Timer Control] command, and then click [Stop Timer] under 

[Timer control].  

 
2. Select [Timer Number] on the [Object Property window], and then click [OK].  
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PLEASE NOTE: 
You can create a timer using the [Timer Control] command and the [Equation Calculation Text Box] command.  
 
1. Execute the [Insert-Text-Equation Calculation Text Box] command, and then insert it into the slide window by 

dragging it.  
2. Double-click the Equation Calculation Text Box on the [Object List window] to open the Object Property window, 

and then select a timer function.  

 
3. Fill a color using the [Color and Line] tab, and then click [OK]. (For example, white)  

 
4. After selecting the Equation Calculation Text Box, choose [Hide Object] by right-clicking, and then set Hide 

Name.  
5. Click [Start Timer] under the [Control-Object Control-Timer Control] command.  
6.  Select [Show Hidden Object] on the [Object List window] of timer control. In the case of Hide Name, choose the 

name hidden in the No. 4 process and use 0 as timer number.  

 
7. If you have a preview of the timer by pressing [F5], it will start working.  
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15 TEXT 
You can insert text boxes, equation calculation text boxes, slide numbers, tables, and special characters in 
the [Insert-Text] group and set fonts and paragraphs using the [Home-Font] group and the [Home-Paragraph] 
group.  

 
 

Text Box 
1. Execute the [Insert-Text-Text Box] command.  

 
2. Insert a text box into the slide window by dragging it, and then enter text.  

 
3. To change the properties of the text box, double-click the text box on the [Object List window].  
4. (Optional) To specify the size of the text box and show the scrollbars, click [Manually Fit (Show 

Scrollbar)].  
Alternatively, to run it in edit mode in which you can input text, select [Run in Edit Mode]. 
Alternatively, to run it in read-only mode, select [Run as Read Only].  

 
5. Change the [Inner Margin] and [Border Width] of the text box, and then click [OK].  
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Expression Text Box 
If you enter a expression equation, it will show the built-in function results including the slide number, current 
date, etc.  

1. Execute the [Insert-Text-Expression Text Box] command.  

 
2. Draw a text box by dragging it on the slide window.  
3. Double-click the Expression Text Box on the [Object List window] to open the Object Property 

window.  
4. Select [Output after Equation Calculation] under the [String Output Method] item on the [Object 

Property window]. After selecting a built-in function, click [OK].  
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Slide Number 
You can display the total number of slides and the number of the current slide.  

1. Execute the [Insert-Text-Slide Number] command.  

 
2. Double-click the slide number on the [Object List window] to open the Object Property window. After 

selecting [Number Type], click [OK].  

 
 

Table 
1. Execute the [Insert-Text-Table] command.  

 
2. Enter [Column(C), Row(R), Width(W), and Height(H)] in the [Table] dialog box, and then click [OK].  
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Special Character 
1. Execute the [Insert-Text-Special Character] command.  

 
2. If you choose a special character in the [Character Map] dialog box, and then click [Select], the 

character to be copied will be selected.  

 
3. If you execute the [Home-Clipboard-Paste (Ctrl+V)] command, the chosen character will be entered 

in the text box.  

 
 

Font 

 
n Font Type: You can set a font type.  
n Font Size: You can adjust the character size in units of points.  
n  Increase Font Size: This increases the character size by 1 point.  
n  Decrease Font Size: This decreases the character size by 1 point.  
n  Bold: This makes characters appear with thicker strokes.  
n  Italic: This makes characters slant to the right.  
n  Underline: This underlines characters.  
n  Outline: This makes characters appear with outlines.  
n  Font Color: This sets the color of characters.  
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Paragraph 
You can edit paragraphs in the [Home-Paragraph] group.  

 

n  Align Top: This aligns the text to the top.  
n  Align Middle: This aligns the text to the middle.  
n  Align Bottom: This aligns the text to the bottom.  
n  Decrease Indent: This decreases the indent level of a paragraph.  
n  Increase Indent: This increases the indent level of a paragraph.  
n  Line Spacing: This adjusts the spacing between text lines.  
n  Align Left: This aligns the text to the left.  
n  Align Center: This aligns the text to the center.  
n  Align Right: This aligns the text to the right.  
n  Bullet: Clicking this lets you use bullets for the text. Clicking it again removes the bullets from the 

text.  
n  Numbering: Clicking this lets you use numbering for the text. Clicking it again removes the 

numbering from the text.  
n  Left to Right: The direction of reading the text starts from the left. This function is used in English 

text, Korean text, etc.  
n  Right to Left: Line Left to Right: The direction of reading the text starts from the right. This 

function is used in Arabic text, etc. 
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16 DRAWING AND DIAGRAMS 

Draw 

 

n  Text Box: This inserts a text box where you can type text.  
n  Line: This draws a straight line. You can draw lines straightly at intervals of 15 degrees by 

dragging your mouse while holding down the Shift key.  
n  Curve: This draws a curved line. Every mouse click generates a reference point for line curving. 

Pressing Esc or double-clicking completes the line drawing.  
n  Circle: This draws a circle.  
n  Rectangle: This draws a rectangle.  
n  Polygon: This draws a triangle by default. You can change the [Number of Side] on the [Object 

Property window] to draw a polygon.  
n  Shape Fill: This fills the inside of a shape with the selected color.  
n  Shape Outline: You can change the outline color of a shape.  

 
 
 

Diagram 
You can enter a complex diagram conveniently.  
By using the 2D coordinate system, you can create a compound diagram based on the basic diagram 
through the Group function. You can also transform it freely.  

1. Execute the [Insert-Editor-Diagram] command.  

 
2. Set a canvas in the [Home-Canvas] group of the [Daul Diagram] dialog box. Afterward, select the 

diagram you want in the [Home-Draw] group, and then draw a diagram by dragging your mouse on 
your task window.  

 
3. To add some text, go to the [Tool-String] group.  
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4. To reuse the created diagram, add it to the Template group by executing the [Template-Append 
Template] command.  

 
5. When the creation of the diagram has been completed, insert it by executing the [File-Insert and Exit] 

command.  
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17 MATH EQUATIONS AND GRAPHS 

Math Equation 
You can easily create not only a simple arithmetic expression but also a complex math equation by means of 
a math equation template and a math equation command.  

1. Execute the [Insert-Editor-Equation] command.  

 
2. Select Classification of Math Equations in the [Home-Category] group of the [Daul Equation] dialog 

box. Afterward, select Math Equation in the [Home-Symbol] group, and then create a math equation.  

 
3. To reuse the created math equation, add it to the Templates group by executing the [Template-Add 

Template] command.  

 
4. When the creation of the math equation has been completed, insert it by executing the [File-Insert 

and Exit] command.  
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Graph 
You can create the graph you want easily and quickly by using a math equation.  

1. Execute the [Insert-Editor-Graph] command.  

 
2. Execute the [Home-Drawing-New Graph] command of the [Daul Graph] dialog box.  

 
3. Enter an equation in the [Add Graph] dialog box. In case of a complex equation, express it using the 

[Insert-Editor-Equation] command, and then copy when using it.  
4. To edit a label, execute the [Home-Drawing-Label-Change Label] command, and then edit it in the 

[Edit Label] dialog box.  
5. To reuse the created graph, save it to Template by executing the [Template- Template-Save 

Template] command.  

 
6. When the creation of the graph has been completed, insert it by executing the [File-Insert and Exit] 

command.  
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18 QUIZ 

Multiple Choice Quiz 
You can create a multiple choice quiz and use it for evaluation.  

1. Execute the [Insert-Quiz-Multiple Choice Quiz] command.  

 
2. Enter the body and Quiz choice of the inserted multiple choice quiz.  

 
3. Click Choice Symbol in the Quiz choice, and then check the correct answer.  
4. Run the slide by clicking the [Shift+F5] key, and then confirm by solving the quiz.  

 

p Moving Quiz 
When the mouse pointer over the selected quiz is shaped like an arrow  or a hand 

, move the whole quiz by dragging the mouse.  

    
 

p Adjusting the Spacing between the Quiz Body and the Quiz Choice 
If  you click the Quiz body, a green control point  will appear in the body. Adjust the 
spacing between the Quiz body and the Quiz choice by dragging the control point.  
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p Adjusting the Spacing between Quiz Choices 
If  you click one of the Quiz choices, a green control point  will appear in the f irst Quiz 
choice. Adjust the spacing between the Quiz choices by dragging the control point.  

  
 
 
 

Short Answer Quiz 
You can create a short answer quiz and use it for evaluation.  

1. Execute the [Insert-Quiz-Short Answer Quiz] command.  

 
2. Enter the body and correct answer of the inserted short answer quiz.  

 
3. Run the slide by clicking the [Shift+F5] key, and then confirm it by taking the quiz.  

 

PLEASE BE CAREFUL:  
The text box for entering the correct answer of the short answer quiz is an edit mode text box and a window object. If 
it overlaps with a general object, the text box for entering the correct answer will be displayed over the general object.  
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Quiz Properties 
Double-click Multiple Choice Quiz or Short Answer Quiz on the [Object List window], and then change its 
properties on the [Object Property window]. 

 
 
[Multiple Choice Quiz] Object Property window      [Short Answer Quiz] Object Property window 

 
 [Choice] items and [Answer Count] are the properties of the multiple choice quiz; [Correct Answer Decision] items 
are the properties of the short answer quiz.  

n Quiz ID: This is the ID of the quiz to be controlled.  
n Quiz Number: You can assign a number to the current quiz.  
n No. of Choice: You can set the number of choices.  
n Horizontal/Vertical: As a quiz arrangement order, you can decide how many quizzes you will insert in the 

width and in the height.  
n Choice Symbol: You can set choice symbols by choosing from among [Circle Number / Radio Button / 

Check Button / 1, 2, 3, 4 / a, b, c, d / A, B, C, D].  
n Choice Arrange: Clicking [Regular] causes the choice positions and intervals to be arranged in a regular 

way; selecting [Irregular] causes the choice positions and intervals to be arranged in an irregular way.  
n Choice Shuffle: Every time a quiz is run, this function changes its quiz choice order at random.  
n Show Answer: This displays the correct answer when you check it.  
n Answer Count: You can choose one or more answers.  
n Correct Answer Decision: This is the property of a short answer quiz.  
n Ignore Space: You can ignore word spacing when marking (grading).  
n Ignore Case: When the correct answer is shown in English, there is no distinction between capital and 

lowercase letters .  
n Ignore Punctuation: You can ignore punctuations when marking (grading).  
n Attempt Count: You can choose the number of attempts to take a quiz.  
n Point: You can specify the number of points allotted to a quiz and confirm the scored points in [Quiz Report].  
n Disable Solve Again: This allows only one attempt to take a quiz.  
n Show Explanation: You can enter an explanation and show it when the checkbox is checked. 
n Correct Answer/Incorrect Answer/Retry  
n Message: A message appears in the form of the [Correct Answer/Incorrect Answer/Retry] message box, 

and you can change the message.  
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n Action: You can choose an action for running [Correct Answer/Incorrect Answer/Retry].  

 
n Sound: You can provide a sound effect by inserting a [Correct Answer/Incorrect Answer/Retry] sound file.  

 

PLEASE NOTE: 
You can use the [Show Hidden Object] action to provide the correct/incorrect answer result to the learners when they 
click Submit Button.  
 
1. Insert the picture using [Insert-Object-Image], and then execute the [Hide Object] command by right-clicking.  

 
2. Enter [Hide Name] in the [Hide Object] dialog box, and then click [OK].  

 
3. Select [Show Hidden Object] for the [Correct Answer] action on the [Object Property window] of the quiz. 

Afterward, select the hidden object in the [Show Object] dialog box, and then click [OK].  

 
Set the [Incorrect Answer/Retry] actions in the same manner.  



 

 
90 

4. Run the slide by clicking the [Shift+F5] key, and then confirm it by taking the quiz.  
A picture appears on the screen as shown below when the answer is correct.  

 
 
 
 

Submit Button Properties 
To change the shape of the [Submit Button] button, select the [Submit Button] button of the quiz, and then 
open the Object Property window by clicking [Object Property] by right-clicking or double-clicking the quiz on 
the [Object List window], and then change the properties of the button.  

 
n Button Name: Enter the characters displayed on the button.  
n Button Shape: Choose from among [Default Button, Color Button, Region Button, Image Button, and Text 

Button].  
For details, please refer to Button Shape under Working with Buttons.  
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Quiz Report 
This function shows the result report of the quizzes taken by the learner according to the number of points 
allotted to each quiz.  

1. Execute the [Insert-Quiz-Quiz Report] command.  

 
2. The following quiz report appears on the slide window by means of an expression text box.  

   
3. Change the quiz report by deleting some items or by changing the text box fonts if necessary.  
4. Run the slide, solve the problems, if any, and then confirm the quiz report.  

 
 
 

Quiz Result 
The learner can check the correct answer for each quiz he/she has taken.  

1. Execute the [Insert-Quiz-Quiz Result] command.  

 
2. Select the inserted [Quiz Result], and then adjust its size by dragging the control point .  
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3. After selecting the quiz result on the slide window, open the Object Property window by selecting 

[Object Property] by right-clicking or by double-clicking the quiz result on the [Object List window], 
and then change its properties.  

 
n Arrange Order: You can choose between [Arrange Horizontally] and [Arrange Vertically].  
n Horizontal Count: This specifies the horizontal count.  
n Vertical Count: This specifies the vertical count.  
n First Number: This specifies the first number.  
n Last Number: This specifies the last number.  
n Correct: You can choose the shape to be displayed when the answer is correct.  
n Incorrect: You can choose the shape to be displayed when the answer is incorrect.  

4. Run the slide, solve the problems, if any, and then check the quiz result.  
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19 EXPORTING CONTENT 
You can save your documents in various file formats to distribute content.  
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Save as Web Page (Ctrl+Alt+S) 
You can save your file as an HTML file to make it available on the Web. LectureMAKER supports HTLM5.  

1. Execute the [File-Export] command.  
2. Click [Web Publishing] in the [Export] dialog box.  
3. Choose [LectureMAKER] or [HTML5] in [File Format], and then click [Export].  

 
4. Select the save location in the [Save] dialog box, enter the file name, and then save.  

 
 

p Differences between Active X content and HTML5 content 
If  you save the f i le format with the LectureMAKER Viewer, it wil l run the f i le by means of 
ActiveX on a Web browser.  
The differences between ActiveX and HTLM5 are as follows:  

 ActiveX HTML5 
Supports viewer resizing NO YES 
Slide transition effect  YES NO 
Object switching effects 
(including animation) 

YES Supports some switching 
effects  

RTL YES NO 
MIME type that needs to be 
registered on the server 

Please refer to Content 
Distribution. 

Please refer to Content 
Distribution . 

Supports electronic pen  YES NO 
Automatically plays when 
loading a video  

YES May differ according to 
Web browser support  

GET/PUT YES Can be processed only 
when the object is 
completely included in the 
selected region  
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Save as SCORM 
SCORM stands for Sharable Content Object Reference Model, a standard for interoperability and reuse of 
the learning object. If you package files in single SCO or by separating them into several SCOs, they will be 
compressed and saved as a Zip file, and sequencing and navigation information will also be added and 
saved.  

1. Execute the [File-Export] command.  
2. Click [SCORM] in the [Export] dialog box.  
3. After selecting [SCORM packaging], select [File Format] and [SCORM version], and then go to the 

next step.  

 
4. After selecting Learning Structure, determine the size of SCO by entering the chapter name or 

section name, and then click [Export].  

 
5. Select a save location in the [Save] dialog box, enter the file name, and save.  
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p SCORM Packaging Method 
n Step 1 Learning Structure 

4 SCOs are packaged in units of sections as entered.  
 

 
Section Applicable Slide 
chap1 Slide 1, 2 
chap2 Slide 3, 4 
chap3 Slide 5, 6 
chap4 Slide 7, 8, 9 

 
 

n Step 2 Learning Structure 
4 SCOs are packaged in units of sections for each chapter as entered.  
 

 
Chapter Section Applicable Slide 
chap1 section1 Slide 1, 2 
chap2 section2 Slide 3, 4 
 section3 Slide 5, 6 
 section4 Slide 7, 8, 9 

 

PLEASE NOTE: 
You can set acceptance criteria for learner evaluation points for each content and deliver them to LMS (Learning 
Management System).  
If you enter acceptance criteria in [SCORM Mastery Score (0~100)] after executing the [File-Option] command, the 
inputted points will be reflected by percentage.  
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Save as SCO Unit 
You can save your file without any separate packaging to utilize it as SCO, which is the basic learning unit.  

1. Execute the [File-Export] command.  
2. Click [SCORM] in the [Export] dialog box.  
3. After selecting [SCO], select [File Format] and [SCORM version], and then click [Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  

 
 

Save as Executable File 
You can save your file as an EXE file, which is an executable file.  

1. Execute the [File-Export] command.  
2. Click [Executable files] in the [Export] dialog box.  
3. Choose LectureMAKER or HTLM5 in [File Format], and then click [Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  
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Save as LMD 
You can save your file as LMD file, which you can read in LectureMAKER Viewer.  

1. Execute the [File-Export] command.  
2. Click [Attachment File] in the [Export] dialog box.  
3. Confirm the file format, and then click [Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  

 
 

Save as Design Format 
You can save your file as LMM file, which is a design file.  

1. Execute the [File-Export] command.  
2. Click [Themes Files] in the [Export] dialog box.  
3. Choose [Design Format File] in [File Format], and then click [Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  
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Save as Template 
You can save your file as LMT file, which is a template file format.  

1. Execute the [File-Export] command.  
2. Click [Themes Files] in the [Export] dialog box.  
3. If you want to choose [Template File] in [File Format] and save only the object frames, check [Delete 

the content(text, file), then save the object], and then click [Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  

 
 

Save as Image 
You can save all the slides or the current slide as an image file.  

1. Execute the [File-Export] command.  
2. Click [Themes Files] in the [Export] dialog box.  
3. Choose [Image File] in [File Format], select the file format and slide scope to be saved, and then click 

[Export].  

 
4. Select a save location in the [Save] dialog box, enter the file name, and then save.  
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20 CONTENT DISTRIBUTION 

Overview 
To publish the content created by using LectureMAKER Authoring Tool on the Web, you must first know the 
differences between saving formats. Please choose the desired format according to the file use. (File-Export-
Save as Web Page)  

Format Use 
LectureMAKER Read it using IE browser. 
HTML5 Read it using Web Browsers (IE, Chorm, Firefox, Safari). 

 
Content Authoring (Teacher) 

n Data file 
- In case of multimedia files, use small-sized files if possible to enhance loading speed.  
- We recommend using WMV files, which can be played smoothly in Windows. Since WMV files can 
be played in Windows Media Player 9 without any special codec installed, ordinary users can use 
them conveniently.  

n File name 
In the case of the default executable file name (*.html), some special characters may cause 
problems with file loading in the web environment. Thus, please use the English letter/number 
format when saving it.  

n Distribution file format 
- ActiveX 

1. Can be used only in Windows.  
2. Supports the following streaming protocols: mms, rtsp, rtmp  

- Html5 
1. Supports cross-platforms (Windows, Linux, Mac) 
2. Supports the following streaming protocol: Not Support 
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Content Uploading (Server Manager) 
n Setting up the MIME type of ActiveX files 

You must set up MIME type on the Web server as follows:  
Extension MIME Type Description 
.deb application/x-dauldeb Electronic board file 
.dvf application/x-dauldvf Diagram file 
.g application/x-daulg Graph file 
.mp4 video/mp4 Video file 
.lmf application/x-lecturemaker Web publishing file (run immediately) 
.lmd application/x-lecturemakerLMD Web publishing compressed file (run 

after download) 
.lme application/x-lecturemaker Source file 
.xedit application/x-daulxedit DaulEdit file 

n Setting up the MIME type of HTLM5 files 
You must set up MIME type of HTLM5 files on the Web server as follows:  
Extension MIME Type Description 
.mp4 video/mp4 Video file 
.webm video/webm Video file 
.ogg video/ogg Video file 

n Streaming Server 
In case of authoring content mainly based on video, we recommend distributing it as an ActiveX file 
format and establishing a dedicated streaming server.  
To use the videos uploaded on the streaming server, please export your content as a 
LectureMAKER file format.  
 
Set up streaming directly in the created HTML file of ActiveX Viewer as follows:  
1. StreamingMediaURL  Use when the source file name and the streaming server file name are 

the same.  
Enter the entire URL of the streaming server except the file name.  
ex) Source file name: source.wmv 

Streaming server file name: mms://media.daulsoft.com/subfolder/source.wmv 
varStreamingMediaURL="mms://media.daulsoft.com/subfolder/"; 

 
2. StreamingMediaRenameURL  Use when the source file name and the streaming server file 

name are different. 
Separate the source file name and the streaming server file URL by comma (,) when entering 
them.  
ex) Source file name: source.wmv 

Streaming server file name: mms://media.daulsoft.com/subfolder1/source1.wmv 
varStreamingMediaRenameURL='"source1.wmv","mms://media.daulsoft.com/subfolder1/source1.wmv"'; 

ex) In case there are several videos:  
varStreamingMediaRenameURL='"a.wmv","mms://xxx.com/a1.wmv","b.wmv","mms://xxx.com/b2.wmv"'; 

HTML5 streaming settings is [file name. Files] set in the file in the folder html5lecture.html.  
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Content Reading (Learner) 
n Installation of ActiveX Viewer 

- When exporting a file, if you have chosen the LectureMAKER file format for your content, install 
LectureMAKER Viewer when reading the file for the first time.  
- If HTML is generated in the exported content, LectureMAKER Viewer is automatically installed, 
and its latest version is always updated.  
- If LectureMAKER Viewer is not the latest version, an error may occur when reading the content.  

 

Differences Between PC Browser and Mobile Browser 
 PC Browser Mobile Browser 
Video is automatically played.  YES NO 
Tooltip YES NO 
Mouseover effect YES NO 
How to move slides Move by mouse click Move by Swipe 
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21 TROUBLESHOOTING 

Video 

Video cannot be played.  
LectureMAKER Viewer plays video files using Windows Media Player. Check again the video that cannot be played 
by playing it in Windows Media Player. If it still cannot be played even in Windows Media Player, install the basic 
codec supported by Windows Media Player 9.  
http://support.microsoft.com/kb/899113 
 
Windows Media Player 9, 10, and 11 versions do not support MP4 files. In case of unsupported video files such as 
MP4, please find the corresponding codec and install it.  
In case of any other video file that cannot be played on your computer, please find the corresponding codec and 
install it.  

 

LectureMAKER shuts down when I play a video. 
If any other recording program such as Logitech Webcam is also running at the same time, the two programs may 
conflict with each other. Please take care not to run any other recording program.  

 

I cannot move to and seek the play slider of a video. (Jumping is impossible.)  
In the case of a video file inserted through URL link, jumping is possible only in streaming mode (mms://, rtsp://, 
rtmp://).  
If you use a general Web server, the video file will be processed in a progressive way, and you can seek it after 
completing download.  
 
If the original video file has been damaged, seeking may be impossible.  
Please correct it with a program such as AsfTools, AsfBin, etc.  

 

You cannot control a video inserted through streaming url at high speed.  
You can play it at high speed only after sufficient bandwidth is secured. For details, please contact the server supplier.  

 

MMS:// protocol videos cannot be played.  
The RTSP/UDP and RTSP/TCP items under the Network tab should be checked in the Options of Windows Media 
Player.  

 

Synchronization between the video and the slides seems to be incorrect at times.  
There are various user environments, and the video loading speed is not always the same even under the same 
operating condition, so there may be a little delay. According to the specifications, an error of up to 0.99 seconds may 
occur.  

 

When recording a lecture, i cannot see the preview screen of video recording.  
Please set up the device you are using by executing the [Insert-Recording-Record Video] command. The video 
recording function of lecture recording is linked to the Record Video command in the Insert menu.  
 

A phenomenon of electronic board screens or video recording screens being disconnected sometimes occurs.  
In the case of some devices, the problem is related to the number of video frames. Please adjust the number of video 
frames.  
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PowerPoint 

I continue to fail in inserting (or reading) Powerpoint.  
LectureMAKER supports only PowerPoint. It does not support PowerPoint Viewer, Hancom Office, or Open Office. 
Please check whether PowerPoint has been installed on your computer. Moreover, if both PowerPoint and 
PowerPoint Viewer have been installed, LectureMAKER may not work normally. Please install only PowerPoint.  
 
If the 0x800401f3 error appears, it means that there is a problem in the PowerPoint setup. In this case, remove 
PowerPoint, and then install it again.  
 
Such problem may occur because the previously run PowerPoint has not been closed completely. Please close the 
remaining PowerPoint Process (POWERPNT.EXE) by force in Task Manager.  

 

I cannot see only some object types such as powerpoint documents, lecture recordings, etc.  
Please add a relevant extension to the MIME type of the Web server.  
For details, contact the server manager or refer to <Content Distribution>.  

 

I have inserted a powerpoint as a picture, but its quality seems to be somewhat poor.  
Please update your PowerPoint with the latest service pack.  

 

I have inserted a powerpoint as a picture, but line breaks and arrangements are somewhat different.  
Please adjust so that the text box area does not get out of the slide, and then convert again.  

 
 

Editor, Text Box 

The line breaks in the text box sentences are displayed somewhat differently.  
In the case of text strings in a text box or a diagram, the slide running screen and the edit screen display them 
identically only when the screen zoom is 100%.  

 

I cannot see the equation characters i am entering on the math equation window.  
The installation of the math equation fonts has not been completed. Please reboot your computer.  

 
 

Web Publishing 

I have opened my content after uploading it on the server, but some objects are not printed.  
There are cases wherein Web servers cannot read some Korean characters, Japanese characters, etc.  
Therefore, to publish your content on the Web, you need to save it under a safe file name using characters such as 
English letters and numbers.  
Data file names are automatically changed to safe file names, so please use a combination of English letters and 
numbers only for executable file names (*.html).  

 

The exit button does not work. The button property is “Close web browser window.”  
The Exit button does not work in Internet Explorer 6.  
Internet Explorer 6 has many problems with security and compatibility because it was released on the market a long 
time ago, and Microsoft does not recommend using it. Please use the latest version of Internet Explorer, if possible.  
 
Because of enhanced security, Internet Explorer 8 works only in Run as Administrator mode.  
 
If both an old version and the latest version of LectureMAKER Viewer have been installed on your computer, it may 
not work normally. Please delete both versions, and then install only the latest version again.  
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Installation, Patch, and Authentication 

Activex cannot be installed on my computer. 
Please try to install ActiveX manually. Click the following path and then install it:  
http://viewer.lecturemaker.com. 
 
Installation may not be executed due to ActiveX filtering. In the case of Internet Explorer, please uncheck ActiveX 
Filtering in the Tool of menu item. 

 

LectureMAKER viewer is not installed automatically after the installation of activex. 
ActiveX OnlineUpdate was installed abnormally. Please click Internet Options > Settings of the Temporary Internet 
Files item > View Objects and delete Kr.DaulSoft.OnlineUpdateAxVC60.inf and Kr.DaulSoft.OnlineUpdateAxVC60.dll, 
and then restart Internet Explorer.  

 

When running an lmd file or a LectureMAKER viewer type html file, I cannot check for updates. 
The update URL path may very likely be blocked due to your company’s internal security policy.  
Please click the following path and install ActiveX manually:  
http://lmviewer.lecturemaker.com 
 
It may be a DNS problem.  
In the DNS settings, change temporarily to another address. ex) Google DNS: 8.8.8.8 / 8.8.4.4.  
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Old Content (LectureMAKER 2.0 File) Compatibility 

When I open the old content (LectureMAKER 2.0 file), some objects are not supported.  
When you open a document created in the previous version of LectureMAKER, if it contains functions that are not 
supported by the current version, a [Compatibility Checker] will appear as follows:  

 
 
In the case of objects not supported by the current version after the compatibility test, the following message will be 
displayed:  

 
 
Even if the document is saved with some objects not supported, they will not be deleted but maintained.  
 
n Previous Version Functions Not Supported by the Current Version  

Insert-Object-Flash  
Insert-Object-Documents-PowerPoint: As PowerPoint Document, As PowerPoint Slide  
Insert-Object-Documents-PDF: As PDF Document  
Insert-Object-Mid files among the audio files 
Insert-Editor-Image Editor  
Insert-Text-Archaic  
Control-Object Control-Document Control  
Home-Draw-Paint  
View-HTML Tag-HTML Tag  
File-Save As-Save as Web Page-Save Flash  
[Chain and run other LectureMAKER file], [Another file (*.exe, *.html, .)] among the button functions  
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Others 

I inserted two electronic board objects into the same slide, but i cannot run them at the same time.  
Running videos containing the same sound, electronic board and ID have no effect, the problem may likely be due to 
malfunctioning.  
Therefore, only the last video is run according to the specifications.  

 

When I printed a document, the background of some objects was displayed in black.  
The transparent area of an object has a bug, i.e., being printed in black. (ex. PNG file)  
Please save your document under another file name and export it as an image file, and then print it as image file.  

 

The fonts specified using the authoring tool are not shown on another person’s computer.  
The Windows default fonts are normally shown regardless of the computer environment you are using them in.  
In the case of other fonts, however, the same fonts you are using on your computer must also be installed in another 
computer.  

 

The function of creating new documents (Ctrl+N) does not work.  
You can open up to 9 LME documents only.  

 

I inserted a moving gif, but it stopped when I ran a slide. 
A moving GIF must be inserted as a video.  
If you click File Format on the Insert/Open Video window, the Animation GIF item will appear.  

 

Can I change the default run language version of lme files? (ex. English LectureMAKER → Korean LectureMAKER)  
LME files are connected to the last installed/run authoring tool.  
Run Korean LectureMAKER first, and then double-click the LME file. (Please run it in Administrator mode in Windows 
Vista or Windows 7.)  

 


